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ABSTRACT

This tutorial teaches the creation of rich client applications based on the
Eclipse Rich Client Platform (RCP). Soon after its inception, Eclipse
was used for building applications outside the tools domain for which
Eclipse was originally designed. The Eclipse development team
embraced this trend and with Eclipse 3.0 introduced the RCP that
facilitates the creation of rich client applications. In this tutorial we
describe the overall architecture of an RCP-based application, its
specific components, development, packaging, deployment and testing.
Participants will learn and perform the steps to build their own RCP

Keywords: application. We will show how to develop a minimal application plug-
Development, in, add a feature including custom branding, and package the
Java Application, application for deployment.

Rich Client Application
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Introduction

Today, in the time of World Wide Web,
schedules should have been redone and
refreshed for their expanding significance and
use in our day-by-day life. One should be
alarmed for an occasion for example meeting,
arrangement or some other significant date.
Correspondence through email turns out to be
so normal in this age, it is important to make a
schedule application, by which one can be
alarmed through email. This proposition work
mirrors a solid encounter of Java programming
language, and learning of associating the

applications with database

The advancement methodology for the

application  required the accompanying
advances:

e Layout of the Ul

e Coding for the application

e Creation of database for the application

e Connecting the database with application

e Addition of email usefulness in the

application

Java is a processing stage and abnormal state
programming language, which was grown

initially by James Gosling at Sun

Microsystems. A group at Sun Microsystems
named "green group" began taking a shot at
Java language venture in 1991, which was at
last discharged in 1995. Java has its linguistic
structure like and got from C, C++ dialects.
Except if different dialects, in which one needs
to either arrange or decipher the code before
use it, in Java we need to accumulate and

translate code to run it.

Generate the Most Basic RCP Application
Obscuration accompanies a wizard to make a
rich customer application. This gives you a
skeleton for all your own improvement. This
wizard fundamentally plays out the manual
advances that Ed Burnette depicts in his RCP
tuorial [Eclipse Powered]. To make our life
more straightforward, we utilize the wizard.

e Create another module venture

e Project name: rcpdemo

Next
e "Might you want to make a rich

customer application?" > Check "Yes"
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Newr Plug-in Project

Plug-im Content
Enter Hhe data required bo generabe the plug-n.

'm.l 8
L

Plug-in Properbes

Flugrin 10 [repdema
Flug-n Wersion: | 1.0.0
FloginMame: | Riopdemo Mugqn
Phocrin Provider: |

Runtme Library: I-'.:pdem:l.]a'

Piug-in Oas=

[« Ganersks the lawa claes that corbrols ta plug-n's Efa cycle (racomnmended)

Closs Hame: | roudemn, RepoemoFlugn
W This plug-n il make contribubions bo bhe LI

Rich Ciert Appleation
‘Woud vou k= o oeate & rich dient spplcation? i+ ez 0 No

L md ] e ] : Cares

e On the Templates page, check the box e The “Overview” tab shows the plug-in
and select the “Hello RCP” template ID and the name of its plug-in class.
e C(Click “Finish” This creates a project
that contains the most basic elements of
a rich client application. The wizard
opens the Plug-in Manifest editor. Let
us quickly go through the different tabs.
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(B e % G S
Qverview @
General Information Plug-in Content
This section describes general information about this The content: of the phug-in is made up of Four
plug-n: sections;
1D Lepdemo \ 4 Dependencies: lsts al the plug-ins requred
version: 11.0.0 ‘ on this plug-in's dasspath to comgde and run,
0N, AIN | ! ) / ) ] )
N - {4 Runtime: §sts the lbraries that make up this
idd“ B (Rcpdese PO : plug-in's runtime.,
TN 74 Extensions: dedares contributions this plug-
Class:  repdemo RepdemoPlugin Browse.,. in makes to the platform,
i_-'_' Exlersion Points: declarss new Function
porits this plug-in adds to the platform,
Testing (2)  Exporting @
You can test the plug-in by laurching a second To package and export the plug-in:

(runtime) Instance of an Eclpse spplcation: 1 Spodity What iesds to be packeged i

9 Launch an Ecipse sppication deplayable piug-in on the Buld Configuration
%% Launch an Eclpse applcation In Debug mode page
2. Export the phag-In In a Format sukable For
deployment using the Export Wizard

Overview | Dependences | Runtime | Extensions | Extension Ponts Bulld phogn. xml | buld properties

The "Conditions" tab just demonstrates the accessible at runtime. This degree is significant
immediate conditions. It doesn't indicate for application arrangement. We will see later,
aberrant conditions. For running a rich how the dispatch design wizard can process the
customer application, it needs to have all entire degree of required modules dependent
immediate and backhanded ward modules on this reliance data here.
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= -
Dependencies
Required Plug-ins Dependency Propertics
Speciy the st of plug-ins required For the operation of Define the properties of the selected dependency:
this plug-in: m|
Hsdorg.echipse.u O
f‘-"\txorg.edipse.core.nrtme

Yersion to match:

Mabch rule

HEE

« Dependency Analysis
&G ook for cycles in the degendancy araph
% Compute Dependancy Extent

"‘5 Find unused dependencies
-; -1

<

|

Overview Dependancies Runtime  Extensions | Extension Points | Buid duoh.xni'bui-d.proper'tief

In the “Extensions” tab we see, that our plug-in perspective. We will revisit the implementing

defines a new application. It also defines a new classes in a second.
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Extensions

Al Extensions

B O eclipese, core, runtime, application

= K] (applcation)

(X repdemao. Riopdsmodppdicatio E

=| = org,eclipse, ui.perspectines

x| Sampls Perspective (perspectivg :I

Body Text

Cwverview  Dependences Runtime Extersions Extenson Poi... Build MANIFEST.MF plugn.xml  build.propert.,..

Extension Details
Sat the properties of the selected exbension,

| appbcation |
Name: [ |

Pant |urg.ec|pse.cu:e.r-_nt|rne.appkatm |

%7 Eind delaring extension point

=5 Open axbansion point descripbion

The new project wizard also created all the
necessary source code for the rcpdemo
application. Before we review this source code,

we want to launch the application.

Starting an RCP Application

A traditional commitment to Eclipse comprises
of a lot of perspectives, editors, points of view,
and so on that expand the current workbench.
A rich customer application, then again,
replaces the outstanding Eclipse workbench. If
there should arise an occurrence of rcpdemo it
doesn't characterize a view that could be begun

inside the traditional workbench.

In this manner, to begin a rich customer
application, we have to characterize the
arrangement of modules and point to the
application that replaces the old-style
workbench. This is done in the dispatch
arrangement. The module show manager gives
a helpful method to make the suitable dispatch

arrangement (see the screen capture above).

e Switch back to the "Outline" tab.

e Click on "Dispatch an Eclipse
application
Presently you should see the most

essential workbench window.
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Now review the launch configuration (Run>Run...>Eclipse Application)
& Run ,ﬂ
Create, manage, and run confiqueration oy
Creats en.‘_v‘h:?ch.nlu,-lcu o oen ECpee 4-,“_-:::'.. @

Canfigueations: Mame: | Echpse Appiication
@ Sohpsa Apnicaton

Eckpse Apokcation

1 Man I‘r-'.‘; Pughs | B Confiqueation | = Tracing | B8 Ervaronmert | 5 Saurce | T Common |

B Tova bppict

7 Sava Appiication Workspace Data

_'l:’ :_3:: Flug-in Test Location: l citookls bpssirontime-Edpsadoni ol on v] ‘_ln!nm... 71
= ST Aophzation I dear woekspace ceta before launching

-

Program to Run

% Run an apgdeation:  |repdamo.epplicaton l
R s product: [ ( _J
Command Line Sattings

Java Lomcutabls; % defadt O pave

Rurking PF: [i7et.4.2_ 00 =] inzteled REs.. |
W Arguneads: l

Program &g averts: |

Bootstrap Entrias: [

tow | odus | L
| AN | Chse |
The “main” tab specifies a location for discuss later, how to run the rich client
workspace data. As “Program to Run”, the application as a product.

rcpdemo. Application is selected. We will
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The “Plug-ins” tab lists all the necessary plug-
ins. Based on the list of direct dependencies as
listed in the plug-in manifest, the launch

configuration lists all direct and indirect

dependencies.

© Run El
Create, manage, and run configurations o
Create a configuration to launch an Ecipss applcation, w
Conlgur atwons: Name: | Eclose Apphzation
= @ Echose Applcation
ofmmEm -, - a
W) Java Applet Clmsn 2 Pugrs | B Configuration | 42 Tracrg | 18 Erwronment | % Sowrce | = Commen
7] Jwva Appheation 7 Launch with all workspace and snabled sxtermal phog-re
",‘ Ak O Use features in the workspace (shrefated nomal startup)
Ju st Flug-n Test v
S0 SWT Application & Chooss phug-re and fragments to launch from the let
B 3¢ workspace Plug e ~ Salact Al J
[ 4> repdemo (1,0.0) g
0 2 External Plagins Dypsedact Al
0% org.apache ant (1,6.2)
D’;- org. apache Jucere (1.4.3) Add Worling Set... I
D% crg.adpes.ant.cors (3.1,0) Add Reguared Phg-ns
%~ ceg.edipse.ant.ui (3.1.0) —”—M—]
0% org.adpss. compars (3.1,0) Restore Def auls
| M % crg.edipse.core.boot (3.0.0) \
7 Indude fragments when computing required phug s
vV Induds gotional depandencies wihen comotng requnsd phag-res
I Add new workspace plug s to this launch configuration automaticaly
Vabdutn Phgan Set
| Run I Close |

The “configuration” tab specifies the location
of configuration information. Review the

“config.ini” file that is found in that directory.

Tip: open this file inside Eclipse using File >
Open external file... and navigate to
“\.metadata\.plugins\org.eclipse.pde.core\Eclip

se Application\config.ini”.
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|#Eclips= Runtime Configuration File
#Sun Jan 09 21:51:36 CET 2Z00S
o=gi.bundles.defaulcSctartLevel=4

osgi ..configuration.cascaded=TfTalsese

osgi.bundles=reference’ :filel :Ch : fProgramme,/eclipse—3 .1

o=gi.inscall .area=file ch Vi Programiely'eclipse—3 . 1M4
o=gil.framewvork=1file’ : Ch : fProgramme//eclipse—-3 . 1M4/ p lucgin:

< >
The file contains a list of all plug-ins that are Basic Elements of an RCP Application
listed in the “plug-ins” tab and is generated Let's review the source code of the rcpdemo

from that table. The OSGi runtime reads the application.

static list of plug-ins from this config file.

- 3 rcpdemo
= 3] RcpdemoPiugin.java
= & RepdemcFiugin
° phagin
@ getDefault()
& getimageDescriptor(String)
@ 9=tResourceString(String)
o resourceBundle
& rRepdemoPiuging)
@ g=tResourceSunde()
@, start(BundleContext)
@ stop(GundeContaxt)
— £ rcpdemo.rcp
— |[J] Applcabion.java
= C Appication
@. run(Object)
— [J] ApplcabionActiorBarAdvisor java
- (@ ApplcationActonBarAdvisor

It consists of the classes

& ApglicationActionBarAdvisor{ 1ActiorEar Configurer)

“a FllMenuBar{IMecriManager)
Ca makeActions(IWorkbenchWindow)
~ [J) Appicabon’\orkbenchadvisor. java
- (& AppicationWorkbenchadvisor
¥ PERSPECTIVE_ID

@ createWorkbenchWindowadvisor{ I'Wor kbenchWindowConfigurer)

@. getlnitialWindowPerspectveld()
= 4] Appication\WorkbenchWindowsidvisor . java
= @ appicationVWorkbenchWindowAdvisor

& ApdicationWorkbenchWindowAdvisor(TWorkbenchWindowConfigurer)

@ createdctionBar Advisor(IAactionBarConfigurer)

@ prewindowOpen()
= |J] Perspective.java
= O Perspective
@. creat=Inktisdlayox(IPagelayout)
+ B, Plug-in Dependencies
+ BN, JRE System Ubrary [2rel 4.2_04]
| bulid. properties
43 plugn.xmi
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a) RCP Demo Plugin: Since each rich Application ~ Workbench ~ Window
customer application is an Eclipse Advisor.
module, it needs a module class. The f) Application Workbench Window
created execution gives access to the Advisor: The workbench window

b)

d)

module occasion and loads the asset
group.

Application: This is the bootstrap class
for the rich customer application. This
class makes and runs the workbench
that contains the headliner circle.
Viewpoint: To  mastermind Ul
components inside the workbench, you
in fact need a point of view. Until
further notice, it doesn't contain
anything intriguing, since the rcpdemo
application doesn't contain any view or
editorial manager.

Application Action Bar Advisor: The
activity bar consultant gives snares to
filling the diverse activity bars like the
menu bar and the cool bar. It likewise
arranges the status line and makes the
activities.
Application Workbench Advisor:
The workbench guide gives various
snares around the lifecycle of the
workbench itself. One of the most

significant occupations is to give the

guide gives various snares around the
lifecycle of the workbench window. For
instance, it permits to set the window

size before it is open-end.

RCP Application as a Product — RCP Mail
Subsequent to acing the initial steps with the

most straightforward rich customer application,

we need to

investigate a progressively

complete model

In the PDE point of view, make another
module venture

Name: rcpmail

Next

"Might you want to make a rich
customer application?" > Check "Yes"
Create a module utilizing the "RCP
Mail Template". You should peruse the
short depiction of the layout.

Finish

Start the new rcpmail application and

watch the new includes.
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*+ RCP Product

file Help
+ &4

# & [N | 4 Message 22

+ = other@aol,com

From:

Date:  10:34 am

sample shows how to:

Subject: This is 8 message about the cool Eclipse RCP!
nicole@mail.org

This RCP Application was generated from the PDE Plug-in Project wizard, This

- 3dd a top-level menu and toolbar with actions
- add keybindings to actions
- create views that can't be closed and

multiple instances of the same view
- perspectives with placeholders for new views
- use the default about dialog
- create a product definition

Add Update-Manager to RCP Mail

The update chief disseminates refreshes for an
Eclipse-based application. For the RCP, this is
viewed as a discretionary element. We need to
add it to the rcpmail application. The Update
Manager requires, that we bundle the modules
of our rich customer application as an Eclipse
highlight. By show, include venture names end
in "...- highlight". Since we make a component
for our rcpmail application, we give it the name
"rcpmail-highlight). The element ID, in any
case, must be "rcpmail* rather than the
proposal of the element creation wizard. The
method of reasoning behind this is, each

element requires a marking module. As a

matter of course, the ID of the marking module
is thought to be equivalent to the element ID.
In the element show you could determine an
alternate marking module ID. For our situation,
the current rcpmail module is the marking

module.

1. Create Product Features First, create the
branding plug-in for the new feature that
contain the Eclipse base plug-ins.

e Create a new plug-in project

e Name: rcpmailbase

e Uncheck “Create a Java project”
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Press finish This branding plug-in is required
for the following feature.

e Create an new feature project

e Name: rcpmailbase-feature

e Feature ID: rcpmailbase

e Accept the remaining defaults

e In the list of plug-ins check all plug-ins
that you find in the launch
configuration except “rcpmail” and
“rcphelp”.

e Also add the rcpmailbase plug-in to the
list. (While you are at it, you might
want to add it to the launch
configuration for future reference.)

Now we can create the feature that contains our
own plug-ins.

e Create an new feature project

e Name: rcpmail-feature

e Feature ID: rcpmail

e Accept the remaining defaults

e In the list of plug-ins check “rcpmail”,
and “rcphelp”.

e Press finished

e In the manifest editor on the “Included
features” tab add the rcpmailbase
feature.

e On the “Dependencies” tab, clear the

list.

2. Add Update Ul Action Like for the help
system, we have to add the update manager
dialog to the menu and add some plug-ins to
the launch configuration. Let's see, how the
Eclipse SDK adds the menu entry (Help >
Software Updates > Find and Install) to the
workbench.

e Open the file search dialog

e Containing text: “Find and Install”

e File name pattern: “plugin. properties”

e Scope: Workspace (we assume that you

have imported all Eclipse base plugins

into the workspace).

'Find and Install" - 3 matches in Workspace
- L;_-_‘[ org.eclipse.ui.ide

B plugin. properties
+ 1= org.eclipse.update, k

e Open the  plugin.properties  of
org.eclipse.ui.ide

e This text is defined for the variable
UpdateActionSet.updates.label

e Open the manifest of that plug-in and
look for this label.

e You find an action set definition that
adds the menu entries.

e Copy this definition and adapt it to the

RCP mail application.
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<extension

<actionSet

visible="true"

<menu

id="rcpmail.updateMenu'>

</menu>

<action

point="org.eclipse.ui.actionSets">

label="%UpdateActionSet.label"

id="rcpmail.softwareUpdates">

label="%UpdateActionSet.menu.label"

label="%UpdateActionSet.updates.label"”

icon="icons/usearch_obj.gif"

id="rcpmail.newlUpdates">
</action>

=/actionSet>

=/extension=

class="rcpmail.rcp.InstallWizardAction"

menubarPath="rpcmail.updateMenu"

The show of org.eclipse.ui.ide references the
class org.eclipse.ui.internal.ide.update. Install
Wizard Action to open the introduce wizard.
Since this class lives in a module, that we
would prefer not to rely upon, we have to make
a neighborhood duplicate of it and reference it
from the activity definition. You see this
reference to the nearby duplicate in the piece
above as of now. Note: What? Reorder
programming? You may think, we have lost

our psyches. However, hold up a moment. In

the event that we need to summon the
introduce wizard, we have to give an activity
that carries out that responsibility. Such an
activity exists in Eclipse, yet inside a module
that we would prefer not to add to our
necessities list (org.eclipse.ui.ide). Presently, in
the event that you audit the duplicated class
you will discover, that it contains 5 lines of
code that really accomplish something. We
adjusted this code duplication against the

overhead of including the undesirable module
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dependency and found that we made the best
decision. We even can hope to get the favors of
Erich Gamma and Kent Beck, since we
pursued their "Monkey see, monkey do™ house

rule.

This replicated class references some code
from org.eclipse.update.ui module.

e Add it to the conditions rundown of the
rcpmail application — not to the venture
assemble way. Spare the module show.

e Open the dispatch design and in the
modules rundown press "Include

required modules”

e Run the dispatch design and open the

Install Wizard.

Conclusion

Overshadowing is a multi-lingual
programming advancement condition, which
comprises of  coordinated

condition (IDE) and additional

improvement
module
framework. An IDE gives a wide range of
instruments for example code composing,
arranging, running, troubleshooting, record the
executives, and documentation all at one single
stage. The clearest approach to construct and
fare and application from inside Eclipse is
accessible straightforwardly in the Ul and you

have utilized those highlights all through this

instructional exercise through the fare wizard.
This advantageous usefulness is given by
org.eclipse.pde.ui. For construct robotization,
be that as it may, the utilization of this
usefulness is debilitated. The fabricate forms in
org.eclipse.pde.ui run no concurrently and in
this manner can't be utilized in insect construct
content, since it can't get together with other
Eclipse forms. Obscuration is one of the IDEs
which are generally utilized expertly to create
applications and programming arrangements. A
preferred position of Eclipse over other expert
IDEs is that Eclipse is an open-source stage,
and subsequently, it is anything but difficult to
include new libraries and assets in it. Its greater

part is written in Java programming language.
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